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OVERVIEW
The purpose of this guide is to help technicians and engineers 
integrate Yaskawa Variable Frequency Drives (VFD) into a new or 
existing EtherNet/IP network, specifically Rockwell Automation 
(RA) Programmable Logic Controllers (PLC). EtherNet/IP (EIP) is 
being used in a wide range of industries and is one of the fastest 
growing industrial protocols in the United States. EtherNet/IP is 
an open source implementation, thus allowing for the continuous 
development and support from industry leaders (such as 
Yaskawa), ensuring that this industrial application layer protocol 
support sustainability. 

Instructions and examples will be based on Yaskawa Tag 
Generator, Yaskawa add-on instructions, RSLINX, and a Compact/
ControlLogix™ PLC platform, configured with the RSLogix 5000 or 
Studio 5000 (RS5K) software environment. This guide will navigate, 
configure and explore the functionality of Yaskawa Tag Generator.

The Yaskawa Tag Generator was developed to allow technicians 
and engineers to select multiple Yaskawa EtherNet/IP products, 
their functions (pre-defined I/O assemblies), and then output 
the compiled data to a Comma Separated Value (CSV) file. Once 
imported into the RS5K environment, these tags are then aliased 
to generic tags created when adding the Yaskawa module[s], thus 
simplifying integration and reducing commissioning time.

USE OF THIS INFORMATION/

DOCUMENTATION
Nothing in this document or any information or data derived 
from this document may be published, distributed or copied, nor 
may the information or data be used to create derivative works.  
No user of this information or data may allow or enable others to 
reverse engineer, decompile, disassemble or otherwise attempt 
to reconstruct, identify or discover any code, underlying ideas, 
techniques, or algorithms from this information.  No confidential 
information or proprietary rights or data may be removed, 
obscured or altered.

All proprietary and ownership rights belonging to EECO shall 
remain with EECO, and nothing in this document shall relinquish 
such rights, title or interest. 

INDEMNIFICATION     
EECO shall be indemnified and held harmless from any and all 
claims, damages, losses and/or expenses, including reasonable 
attorney’s fees arising from any breach of this agreement or the 
user’s obligations hereunder.  
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WARRANTY DISCLAIMER
This document is to be used “As Is” without warranty of any 
kind. EECO, on behalf of itself and any affiliates, hereby disclaims 
all representations, promises or warranties, whether express or 
implied with respect to the information contained herein. EECO 
specifically disclaims all implied warranties or merchantability, 
non-infringement, suitability and fitness for any purpose.   

PRE-REQUISITE SKILLS

This document is written and intended for technicians and 
engineers who will be commissioning and/or supporting Yaskawa 
VFD[s] on the plant floor. The intended users should understand, 
at the very least, navigation through the RS5K software 
environment. 

REQUIRED HARDWARE/SOFTWARE
1.	 Yaskawa VFD with Optional Communication Card- 

(CIMR-VU2A0001FAA - V1000 with the SI-EN3/V in our 
case)

2.	 PC with RSLINX and RS5K

3.	 Rockwell Logix PLC (1756-L71 ControlLogix in our case)

* Note: All Yaskawa EDS files and software may be downloaded from 

Yaskawa.com via links provided in the Appendices.

COMMUNICATION
VFD COMM METHODS     

Initial connection to the Yaskawa VFD can be accomplished in a 
couple of ways:

1.	 	Direct connect via PLC to VFD

2.	 Common Switch or Router Connect via ports on the 
same switch

3.	 Network connection via multiple switches and/or 
wireless access points

VFD DEFAULT CONFIGURATION AND PREPARATIONS

Open DeviceNet Vendor Association (ODVA), the governing body 
of EtherNet/IP, which specifies that all EIP supporting devices, 
including Yaskawa VFD, by default must be set to use Dynamic 
Host Controller Protocol (DHCP) to get the network settings. 

This corresponding requirement is reflected in parameter F7-13 
(Address Mode at Startup: 2 by default). If a DHCP server does 
not exist within the network topology, proceed to change the 
network settings manually to a static setting.

Using the keypad or Drive Wizard Industrial software, the option 
card’s network settings (IP Address, Subnet Mask and Default 
Gateway) can be configured under the F7 parameters. Additional 
User Setting Table information can be found within the Yaskawa 
AC Drive Technical Manual – SIEPC71060618: E.3 - page 491.
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YASKAWA VFD NETWORK PARAMETERS:

•	 F7-01 Ethernet IP Address 1 — 192

•	 F7-02 Ethernet IP Address 2 —168

•	 F7-03 Ethernet IP Address 3 — 1

•	 F7-04 Ethernet IP Address 4 — 1-254

•	 F7-05 Subnet Mask 1 — 255

•	 F7-06 Subnet Mask 2 — 255

•	 F7-07 Subnet Mask 3 — 255

•	 F7-08 Subnet Mask 4 — 0

•	 F7-09 Gateway Address 1 — 192

•	 F7-10 Gateway Address 2 — 168

•	 F7-11 Gateway Address 3 — 1

•	 F7-12 Gateway Address 4 — 1

•	 F7-13 Address Mode at Startup — 0 from 2 to 	 	
become static, then cycle power.

To confirm network settings after the power cycle, we can 
verify the settings under the Monitor parameters U6-80 to 
U6-91. Values are preset if the option card has a connection to 
another device. 

The network LED (NS) should now transition to a solid green state.

ENABLE COMM CONTROLS CONFIGURATION

The following parameters must be changed to enable fieldbus 
controls.

•	 B1-01 to 3: Option PCB (Frequency Reference 
Selection 1) Default is = 1 Analog Input

•	 B1-02 to 3: Option PCB (Run Command Selection 1) 
Default is = 1 Digital Input

*New values will accept immediately without a Power Cycle

PC CONFIGURATION

1.	 Open Network and Sharing Center from the task bar or 
under Control Panel.

2.	 If no connection is present on your PC network port 
(RJ45), select change adapter settings on the left side bar.

3.	 Double click Local Area Connection, then properties, 
and double click on (TCP/IPv4)

4.	 Configure the PC’s static network settings by selecting 
“Use the following IP Address:”

5.	 Input an unused IP Address that is on the same subnet 
as previously mentioned in the VFD configured option.

6.	 Input the same Subnet mask and Default Gateway as 
previously used in the VFD configuration.

7.	 Select OK and OK again on the Local Area Connection 
Properties window and the settings are ready.



ROCKWELL AUTOMATION 
ENVIORNMENTS
RSLINX
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Beginning with v20 of RS5K, this may be 
accomplished with other additional options 
within the environment under the Tools Menu. 

Let’s start off by registering the EATON EDS 
files into RSLINX with the EDS Wizard. 

Open the start menu and under RSLINX

STEP 1:	 Select the EDS Hardware 		
		  Installation Tool

STEP 2:	 Select add
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Select whether you would like to register a single or a directory of 
EDS files. If the latter, please tick Look in subfolders as well. 

STEP 3:	 Browse to the folder directory containing the 	 	
	 	 EDS[s]

STEP 4:	 Click next

The system will do a scan and populate a test result. 

STEP 5:	 Select the desired file[s] to register 

STEP 6:	 Click next
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Change the icons if needed 

STEP 7:	 Click next 

A final task summary window will appear. Ensure the information 
is correct. 

STEP 8:	 Click next to complete the EDS registration 	 	
		  process



STUDIO 5000 
PART 1
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STEP 5:    Select the chassis type 

STEP 6:    Click finish

STEP 1:     Open or create a new project in RS5K. 

If starting a new project -  

STEP 2:	 Select the processor and name your project 

STEP 3:	 Browse to the desired project save location

STEP 4:	 Click next 
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In the Controller Organizer - 

STEP 7:    	 Right click the processor Backplane  
	 	 (slot 0) 

STEP 8:    	 Create a new Ethernet module. 

For this example, the 1756-EN2T will be used. Click create

STEP 9:	 Name the EN2T and input an unused IP 	 	
	 	 Address (192.168.0.2) 

STEP 10: 	 Click OK 

An EN2T module (slot 1) now exists under the Backplane.
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A Yaskawa V1000 VFD will be added to the RS5K project.

STEP 11:	 Right click on the 1756-EN2T module 		
		  and select create new module 

The Select Module Type window appears. To enter the 
V1000 as a Generic Ethernet Module - 

STEP 12:	 Deselect both filters for Category and Vendor 

STEP 13:	 Select only Communication and Allen 		
		  Bradley

STEP 14:	 Scroll down toward the bottom of 	 	 	
	 	 the list and select ETHERNET-MODULE 		
		  Generic Ethernet Module 

STEP 15:	 Click create 

STEP 16:	 A new module window appears
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STEP 17:	 Input a name that is distinctive yet simple 	 	 	
		  (V1000) as you will need to reuse this identical 		
		  name in the Tag Generator Software

STEP 18:	 Change the Comm Format from DINT >> INT

STEP 19:	 Input an unused IP Address (192.168.0.100) 		
	 	 that is on the same subnet as the EN2T, i.e. 	 	
	 	 192.168.0.x. {x = 2-254}.

STEP 20:	 Input 71 for the Input Assembly Instance, 	 	 	
		  size = 2 bytes (INT) (pg. 41 in TOBPC73060092 		
		  Manual)

STEP 21:	 Input 21 for the Output Assembly Instance,  
		  size= 2 bytes (INT) (pg. 41 in TOBPC73060092 		
		  Manual)

STEP 22:	 Configuration assembly is not used, but there 	 	
	 	 must be a value there as a place holder so input 		
		  1 for Configuration Assembly Instance, size = 0 



YASKAWA TAG  
GENERATOR



YASKAWA Integration into EtherNet/IP Networks17

STEP 1:	 Install Yaskawa Tag Generator. Once installed, start the 	 	
	 	 program by double clicking the icon

STEP 2:	 Click New Project in the top menu. 

The new project window will pop up and ask which software do you want 
to create tags for. 

STEP 3:	 Tick Logix Designer/RSLogix 5000 

STEP 4:	 Enter a project name and click New Project to create 		
	 	 the project.
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Once the project is created, select which firmware is running on the PLC. 

STEP 5:	 Click Add New Node 

STEP 6:	 Select the Option Card on the next window

STEP 7:	 Click next
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STEP 8:	 Select the I/O Assembly pair that was used 		
	 	 in the RS5K project (21-71)

STEP 9:	 Delete the Scope field to make the tags 	 	
	 	 accessible globally; otherwise, they will only 	
	 	 be available in MainProgram 

STEP 10:	 Enter a node name, V1000 in this case 

*(MUST BE AN IDENTICAL NAME USED IN RS5K). 

STEP 11:	 Click finish
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STEP 12:	 Click Change Output File and browse to a file 	
	 	 location to save the CSV output file

STEP 13:	 Name CSV file 

STEP 14:	 Click save
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STEP 15:	 Click Build Tag List to generate

STEP 16:	 Click OK in the notification pop-up
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STEP 17:	 Provide a name for the project in the pop-	 	
		  up window 

STEP 18:	 Click Save 

STEP 19:	 The project may now be accessed at a later 		
	 	 time for modificaton.

STEP 20:	 Click Quit and the task is completed. 

The remaining task will be completed in the RS5K 
environment.

STEP 16:	 Click Save Project As
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STUDIO 5000
PART 2
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Navigate back to the RS5K environment - 

STEP 1:	 Go to the Tools Menu > Import > 		
		  Tags and Logic Comments

STEP 2:	 Browse to the previously saved CSV folder location, select, 	
		  and import
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Once the import task is completed, you will 
notice that the lower Error plane provides 
feedback on how many tags were created, 
in addition to any errors and warnings. 

*If there are error[s], ensure that the names 
specified in the RS5K project and Yaskawa 
Tag Generator were identical, or re-run Tag 
Generator with the correct nomenclature.

Also notice that the description column 
is now automatically populated from the 
Tag Generator generated CSV. When 
Edit Tags is selected, RS5K will also show 
exactly where the new tags are alias to in 
the generic tags. The functionalities of the 
Tag Generator tool greatly contribute to 
the reduction of setup or commissioning 
time, ultimately reducing downtime and 
increasing productivity. The import task is 
now completed.
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Yaskawa has taken additional steps to simplifying integration of 
its EtherNet/IP supported products by offering a wide range of 
VFD Add-On Instruction (AOI) in conjunction with Tag Generator. 
Let’s proceed and explore how technicians and engineers can use 
Yaskawa’s AOIs.

In RS5K - 

STEP 3:	 Navigate to File > Import Component > Add-On 		
		  Instruction 

STEP 4:	 Browse to the AOI provided by Yaskawa

The extension of the file will be a L5X. 

STEP 5:	 YAI Assembly 71 21 is selected

EECO | 1440 Diggs Dr. Raleigh, NC 27603 | 919-828-5411 | www.eecoonline.com
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The Import Configuration window appears.

STEP 6:	 Verify and select OK

STEP 7:	 In the Controller Organizer > Add- On 		
		  Instruction, the AOI has been successfully  		
		  imported and is now available for use in the 		
		  Language Element Tool Bar > Add-On



UTILIZING THE  
AOI



YASKAWA Integration into EtherNet/IP Networks29

STEP 1:	 Next, open MainProgram – MainRoutine 

STEP 2:	 Add a rung 

STEP 3:	 Then in Add-On, drag the V1000 AOI to the rung 0

Once the V1000 AOI block is added to the rung, the top three 
parameters in the AOI block must be mapped to a specific module

Within the AOI block - 

STEP 4:	 Double click the top “?” next to the View Configuration 	
	 	 Dialog button

STEP 5:	 Input V1000 > right click > select “New V1000” 

STEP 6:	 A new Parameter or Tag window will appear

STEP 7:	 Confirm the name and scope

STEP 8:	 Click create

Ensure that the Controller Tags and MainProgram windows are 
open and side-by-side. 

STEP 9:	 Select and drag V1000:I1 to the “?” in the Node_Input_	
	 	 Assy row 

STEP 10:	 Select and drag V1000:O1 to the “?” in the Node_	 	
	 	 Output_Assy row

The setup of the AOI is now complete.
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Let’s create a DINT tag —

STEP 11:	 Name it Input_Output. 

The Boolean within the DINT will be used as 
logical Push Buttons. 

STEP 12:	 Add a couple of rungs to the 	
		  project

STEP 13:	 Enable remote FieldBus control 	
	 	 of the V1000 by latching the 	 	
		  V1000_NetCtrl and 			 
		  V1000_NetRef bit

To ensure that the PLC has control after a 
power loss, a First Scan bit is used for latching 
on a power-up condition. 

STEP 14:	 Add a start, stop and fault 		
		  logic to the program, 

STEP 15:	 Download to the processor

The V1000 VFD is ready to be operated. 
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MOTOR TESTING

•	 		Page 42 of TOBPC73060092

SPEED REFERENCE

•	 		Speed Command

•	 		Sets drive speed reference

•	 		Speed reference data: 
	Frequency reference/2SS (SS: Speed scale)

•	 		Setting range: 0 to 0xFFFF

•	 		Example: setting a reference of 4096 with a speed scale of 2: 
	Speed reference data = 4096/22 = 1024 = 0x0400 Hex or 10.24 Hz

•	 	Unit depends on o1-03



APPENDICES
A, B,  C
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YASKAWA RESOURCE 
DOWNLOADS LINKS

 YASKAWA DOWNLOADS

https://www.YASKAWA.com/downloads

 DRIVEWIZARD INDUSTRIAL

https://www.YASKAWA.com/products/drives/
industrial-ac-drives/industrial-software-tools/
drivewizard-industrial

 ETHERNET/IP 

https://www.YASKAWA.com/products/drives/
industrial-ac-drives/industrial-network-
communication-protocols/ethernet-ip

 YASKAWA NETWORK SUPPORT FILES - 
DOWNLOADS

https://www.YASKAWA.com/
downloads?p_p_id=yasdocumentdownload_
WAR_yasdocumentdownloadportlet&p_p_
lifecycle=0&p_p_state=normal&p_p_
mode=view&p_p_col_id=column1&p_p_
col_count=1&_yasdocumentdownload_
WAR_yasdocumentdownloadportlet_
productGroup=Inverter+Drives&_
yasdocumentdownload_WAR_
yasdocumentdownloadportlet_
productLine=Network+Comms-EtherNet-IP

 CONFIGURED PRODUCT FOR A1000 

DRIVE

https://www.YASKAWA.com/products/drives/
industrial-ac-drives/general-purpose-drives/a1000-
configured

 U1000 INDUSTRIAL MATRIX DRIVE

https://www.YASKAWA.com/products/drives/
industrial-ac-drives/general-purpose-drives/u1000-
industrial-matrix-drive

 G7 DRIVE

https://www.YASKAWA.com/products/drives/
industrial-ac-drives/general-purpose-drives/g7-drive

 G7 CONFIGURED

https://www.YASKAWA.com/products/drives/
industrial-ac-drives/general-purpose-drives/g7-
configured

 DRIVEWORKS EZ SOFTWARE

https://www.YASKAWA.com/products/drives/
industrial-ac-drives/industrial-software-tools/
driveworks-ez-software

 PROGRAMMING SIMULATOR

https://www.YASKAWA.com/products/drives/
industrial-ac-drives/industrial-software-tools/
programming-simulator

 ENERGY SAVINGS PREDICTOR

https://www.YASKAWA.com/products/drives/
industrial-ac-drives/industrial-software-tools/energy-

savings-predictor

 HARMONICS ESTIMATOR

https://www.YASKAWA.com/products/drives/
industrial-ac-drives/industrial-software-tools/
harmonics-estimator

 APPLICATION EXAMPLES

https://www.YASKAWA.com/
downloads?p_p_id=yasdocumentdownload_
WAR_yasdocumentdownloadportlet&p_p_
lifecycle=0&p_p_state=normal&p_p_
mode=view&p_p_col_id=column1&p_p_
col_count=1&_yasdocumentdownload_
WAR_yasdocumentdownloadportlet_
lookupType=Software%2FApplication+Examples

 TRAINING DOCUMENTS

https://www.YASKAWA.com/
downloads?p_p_id=yasdocumentdownload_
WAR_yasdocumentdownloadportlet&p_p_
lifecycle=0&p_p_state=normal&p_p_
mode=view&p_p_col_id=column1&p_p_
col_count=1&_yasdocumentdownload_
WAR_yasdocumentdownloadportlet_
lookupType=Training+Documents

 TRAINING: DRIVEWIZARD INDUSTRIAL 

TIPS AND TRICKS

https://www.youtube.com/
playlist?list=PLNAENlyEDCkxPasi-q_
UbSCyqaU7Ryy0v
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YASKAWA SUPPORTED DRIVE PRODUCT SERIES

 A1000

 D1000

 iQpump1000

 MV1000

 P1000

 R1000

 V1000

 V1000-4X

 U1000 Industrial Matrix

 U1000 Oil & Gas

 F7

 G7
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DIRECT CONNECT SERIAL PIN OUT

 Applicable to the A1000, J1000, V1000, V1000-4X, J7, V7, E7, P7, G5, G7, and F7 Drives 

(Courtesy of YASKAWA)
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